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FD-11601 User Guide
The FieldDAQ FD-11601 is an IP65/IP67-rated eight-channel simultaneous voltage
input device that can be connected to external powered and TEDS sensors. It can be
networked and synchronized with IEEE 802.1AS devices.

Figure 1. FD-11601 Front Panel

FD-11601
±10V Powered Sensor Input

STATUS

IN

10 A TOTAL
9-30 V

FieldDAQ
OUT

0

10/100/1000

LINK/ACT

SYNC

1

0 1

2 3

0 1

2 3

BANK 1

BANK 2

SP

AI+

AI–

GND/T–

T+

1
4

5 2
3

1 4
5

2 3

1
4

5 2
3

1 4
5

2 3

1
4

5 2
3

1 4
5

2 3

1
4

5 2
3

1 4
5

2 3

1

4

2

3
5

6

7

8

9

1
2

3

4

5

6

10

1. Power IN Connector
2. Power LED
3. Ethernet Port 0 and LED
4. Bank 1 Voltage Input Connectors 0 through 3 and LEDs
5. Bank 2 Voltage Input Connectors 0 through 3 and LEDs
6. Mounting Holes
7. Power OUT Connector
8. STATUS LED
9. Ethernet Port 1 and LED

10. SYNC Logo
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FD-11601 Basic Information

Kit Contents
Items in your FieldDAQ kit:

■  FD-11601
■  FD-11601 Quick Start
■  FD-11601 Safety, Environmental, and Regulatory Information
■  1 M12 female cap for power IN connector (connected to device)
■  11 M12 male caps for power OUT, Ethernet, and input connectors
(connected to device)

Pinouts
Refer to the following topics for the connector pinouts on your FieldDAQ device:

■ Voltage input connector pinout: Refer to Voltage Input Connectors.
■  Ethernet connector pinout: Refer to Ethernet Ports.
■  Power connector pinout: Refer to Power Connectors.

Driver Support
Earliest driver support version for your FieldDAQ device:

Driver Earliest Version Support

NI-DAQmx 18.5

Table 13. FD-11601 Driver Support
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Cables and Accessories
The following table lists some cables and accessories available for your FieldDAQ
device. For a complete list of FieldDAQ accessories and ordering information, refer
to the pricing section of the FD-11601 product page at ni.com.

Cable/Accessory Part Number

IP67 Power Supply 147464-01
PS-16 Power Supply 781094-01
M125F-Pigtail Power Cable (1 m, 2 m, 3 m lengths) 786172-01/02/03
M125F-M125M Power Cable (0.3 m, 1 m, 3 m lengths) 786173-0R3/01/03
SHM128M-RJ45 Ethernet Cable (1 m, 2 m, 3 m, 10 m lengths) 785944-01/02/03/10
SHM128M-SH128M Ethernet Cable (0.3 m, 1 m, 3 m lengths) 785946-0R3/01/03
SHM125M-Pigtail I/O Cable (0.3 m, 1 m, 3 m lengths) 785950-0R3/01/03
SHM125M-Pigtail-RA I/O Cable (1 m, 3 m lengths) 785949-01/03
FD-11950, M125F Field-serviceable I/O Connector 785941-01
FD-11951, M125F-RA Field-serviceable I/O Connector 785942-01
M12 Torque Wrench, Ethernet and I/O 786181-01
M12 Torque Wrench, Power 786182-01
Universal M12 Male Cap, Plastic 786177-01
Universal M12 Male Cap, Metal 786178-01
Universal M12 Female Cap, Plastic 786180-01
Universal M12 Female Cap, Metal 786179-01
FD-11960, DIN Rail Mounting Kit 786443-01

Table 2. FD-11601 Cables and Accessories

Documentation
Documents that contain information about your FieldDAQ device:

■  FD-11601 Specifications
■  FD-11601 Quick Start
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■  FD-11601 Safety, Environmental, and Regulatory Information
■  FD-11601 Calibration Procedure

Safety Guidelines

Caution Do not operate the FD-11601 in a manner not specified in this
user guide. Product misuse can result in a hazard. You can compromise the
safety protection built into the product if the product is damaged in any
way. If the product is damaged, return it to NI for repair.

The FD-11601 is rated for use in DRY or WET LOCATIONS. Hazardous voltages may
not be connected to the device. A hazardous voltage is a voltage greater than
42.4 V peak voltage or 60 V DC in DRY LOCATIONS, and 22.6 V peak or 35 V DC in WET
LOCATIONS.

Caution All wiring must be insulated for the highest voltage used.

EMC Guidelines

This product was tested and complies with the regulatory requirements and limits
for electromagnetic compatibility (EMC) stated in the product specifications. These
requirements and limits provide reasonable protection against harmful interference
when the product is operated in the intended operational electromagnetic
environment.

This product is intended for use in industrial locations. However, harmful
interference may occur in some installations, when the product is connected to
a peripheral device or test object, or if the product is used in residential areas. To
minimize interference with radio and television reception and prevent unacceptable
performance degradation, install and use this product in strict accordance with the
instructions in the product documentation.

Furthermore, any changes or modifications to the product not expressly approved
by NI could void your authority to operate it under your local regulatory rules.
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Electromagnetic Compatibility Notices

Refer to the following notices for cables, accessories, and prevention measures
necessary to ensure the specified EMC performance.

Notice To ensure the specified EMC performance, operate this product
only with shielded cables and accessories.

Special Conditions for Marine Applications

Some products are approved for marine (shipboard) applications. To verify marine
approval certification for a product, visit ni.com/product-certifications, search by
model number, and click the appropriate link.

Notice In order to meet the EMC requirements for marine applications,
install the product in a shielded enclosure with shielded and/or filtered
power and input/output ports. In addition, take precautions when
designing, selecting, and installing measurement probes and cables to
ensure that the desired EMC performance is attained.

Unpacking

The FD-11601 ships in an antistatic package to prevent electrostatic discharge (ESD).
ESD can damage several components on the device.

Notice Never touch the exposed pins of connectors.

To avoid ESD damage in handling the device, take the following precautions:

■ Ground yourself with a grounding strap or by touching a grounded object.
■ Touch the antistatic package to a metal part of your computer chassis
before removing the device from the package.
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Remove the device from the package and inspect it for loose components or any
other signs of damage. Notify NI if the device appears damaged in any way. Do not
install a damaged device.

Store the device in the antistatic package when the device is not in use.

Hardware Symbol Definitions

The following symbols are marked on your FieldDAQ device.

When this symbol is marked on a product, refer to Safety Guidelines for information about
precautions to take.
At the end of the product life cycle, all NI products must be disposed of according to local
laws and regulations. For more information about how to recycle NI products in your region,
visit ni.com/environment/weee.

5 40e

NI 符合中国电子信息产品中限制使用某些有害物质指令(RoHS)。关于 NI 中国 RoHS 合规
性信息，请登录 ni.com/environment/rohs_china。(For information about China RoHS
compliance, go to ni.com/environment/rohs_china.)

What You Need to Get Started

You will need the following items to set up your FieldDAQ device.
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Figure 1. FD-11601 Installation Supply List
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1. Host Computer running Windows or NI Linux RT
2. Application Software
3. NI-DAQmx Driver
4. FD-11601
5. 5-pin L-coded M12 Power Input Cable
6. 8-pin X-coded M12 Ethernet Cable
7. External Power Supply
8. 5-pin A-coded M12 I/O Cables and Accessories

Note You can either use a shielded straight-through Ethernet cable or an
Ethernet crossover cable to connect the FieldDAQ device directly to your
computer.

Setting up the FieldDAQ Device

Complete the following steps.

1. Install the application software (if applicable), as described in the
installation instructions that accompany your software. Check your driver and
application development environment (ADE) readme files for specific version
compatibility.

2. Install NI-DAQmx from ni.com/downloads/drivers. Complete the instructions.
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3. Register your NI hardware online at ni.com/register when prompted. The last
dialog box opens with the following options:

■  Restart Later to install more NI software or documentation.
■  Shut Down or Restart if you are ready to install your device.

If you have problems installing your software, go to ni.com/support/daqmx.

4. (Optional) Mount the FieldDAQ device to a panel or DIN rail, as described in
Mounting.

5. Make voltage input connections. Refer to Voltage Input Connectors and
Measurements for information about signal connections and guidelines.

6. Align and connect one end of the Ethernet cable to Ethernet port 0 on
the device, and the other end directly to your computer or any network
connection on the same subnet as your computer.

7. Power the device by aligning and connecting the power IN port on FieldDAQ7.
to an external 9 V DC to 30 V DC power source with the 5-pinL-coded M12
power cable. For information about wiring your external power source to
the power connector, refer to Wiring External Power to the FieldDAQ Device.
The FieldDAQ device requires an external power supply that meets the
specifications listed in the FD-11601 Specifications .

The Power LED turns on. Refer to Power LED for information about Power LED
status.

8. To add the FieldDAQ to your software configuration, open NI MAX on your8.
Windows host computer. Expand Devices and Interfaces » Network Devices.

■ If the device is on your local subnet, the device automatically appears in
the list of available devices. Right-click the FieldDAQ device and select Add

Device.
■ If the device is not on your local subnet, right-click Network Devices and
select Find Network NI-DAQmx Devices.

1. In the Find Network NI-DAQmx Devices dialog box that opens, do one
of the following:
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1. Check the box that corresponds to your device in the Hostname
column.
Figure 3. Find Network NI-DAQmx Devices

2. If you know the device IP address, such as 192.168.0.2, enter it
into the Add Device Manually field of the Find Network NI-DAQmx
Devices window, and click the + button.

3. Enter the hostname of the device. The default hostname is
FD11601-<serial number>.

2.
Click Add Selected Devices.

The FieldDAQ device icon changes from white to dark grey, indicating
that it is recognized and present on the network.
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Figure 4. MAX Icons and States

21 3

1. Discovered, but Not Added to the Network
2. Recognized, Present, and Reserved on the Network
3. Recognized, but Disconnected from the Network, Unreserved,

or Reserved by Another Host

If your device does not appear in Available Devices, click Refresh List.
If the device still does not appear, try the following:

1. If you connected the FieldDAQ device directly to your computer,
ensure your network card is configured to obtain an IP address
automatically, then click Refresh List.

Note If you connected the FieldDAQ device directly to your
computer, the setup time may be longer. Wait 30 to 60
seconds after the STATUS LED turns off, then click Refresh

List.

2. Contact your system administrator to confirm that the network is
working and that a firewall is not interfering with discovery. For
additional troubleshooting resources for the FieldDAQ device, refer
to the Troubleshooting Device Connectivity in this guide and the
Finding a Network DAQ Device in MAX topic in the Measurement &
Automation Explorer Help for NI-DAQmx.
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Figure 5. Network Devices in MAX

9. If the FieldDAQ device is not reserved automatically, select the device and
click the Reserve Network Device button. Refer to Reserving the Device in
MAX for more information.

10. Self-test your device in MAX by expanding Devices and Interfaces » Network

Devices, right-clicking your FieldDAQ device, and selecting Self-Test. Self-test
performs a brief test to determine successful device installation. When the
self-test finishes, a message indicates successful verification or if an error
occurred. If an error occurs, refer to ni.com/support/daqmx.

11. Run a test panel in MAX by expanding Devices and Interfaces » Network

Devices » your FieldDAQ device, right-clicking the bank of connectors in your
FieldDAQ device, and selecting Test Panels. If the test panel displays an error
message, refer to ni.com/support. Click Close to exit the test panel.

Note When in use, the FieldDAQ device may become warm to the touch.
This is normal.

Note M12 connectors must be mated to cables or have caps installed on
them to meet IP65/IP67 requirements. Cover the unused connectors with
the included plastic caps whenever water, dust, or dirt are present.

Note Avoid long periods of exposure to sunlight.
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For instructions on networking to a real-time controller, refer to Connecting to a
Real-Time Controller.

Power Connectors and Wiring

The FieldDAQ device has two 5-pinL-coded M12 power connectors, power IN and
power OUT. The power connectors provide one voltage line (V), one common line
(C), chassis ground, and two lines for optional auxiliary power, Aux1 and Aux2.

The following figure shows the power circuitry on the FieldDAQ device.

Figure 6. Power Circuitry

IN OUT

Chassis Ground

Internal Circuit

Aux
V
C

The FieldDAQ device requires an external power source connected between
the V and C terminals, as described in Power Requirements in the FD-11601
Specifications . The FieldDAQ device internally connects the C terminal to the
chassis ground. Recommended NI power supplies are listed in FD-11601 Basic
Information.

The FD-11601 has a maximum device power consumption of 16.0 W. Each FieldDAQ
filters and regulates the supplied power for its tasks.

When FieldDAQ devices are linked together through the power IN and power OUT
connectors, the total current consumption of the chain equals the sum of every
linked FieldDAQ device’s current consumption. The total current cannot exceed 10 A,
and the total supply load of the chain must be less than 300 W.
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You can use the optional auxiliary power lines (Aux1 and Aux2) to draw power for
non-FieldDAQ devices in your network. The FieldDAQ device does not make use of
the auxiliary power itself. If you are connecting power through the auxiliary power
lines, ensure that the total combined current between V Input and Aux power lines
does not exceed 10 A.

Refer to the FD-11601 Specifications for information about the power connectors,
power requirements, and current limits of your FieldDAQ device.

Cap the power connectors when not in use.

Power Connectors

The following figure shows the pinout of the Power IN connector.

Figure 7. Power Connector Pinout
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Pin Number Wire Color* Signal Description

1 Brown V Positive voltage line
2 White Aux2 Optional line for powering non-FieldDAQ devices
3 Blue C Common. Negative voltage line
4 Black Aux1 Optional line for powering non-FieldDAQ devices
5 Gray Chassis Ground. This terminal is internally connected to the

C terminal.
* Wire color pertains to M125F power cables sold through NI. Other manufacturers' cable wire
colors may vary.

Table 3. Signal Descriptions
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Power LED

The green POWER LED on the front panel identifies when the device is powered.

LED State Device Status

On Device is receiving adequate power for its tasks.
Off Device is unpowered or receiving inadequate power.

Table 4. LED State/Device Status

Wiring External Power to the FieldDAQ Device

Complete the following steps to connect a power source to the FieldDAQ device.

1. Verify the power source is turned off.
2. If you are not using a pre-assembled cable, complete the following steps.

1. Connect the positive lead of the primary power source to the V terminal
(pin 1) inside the power connector plug.

2. Connect the negative lead of the primary power source to the C terminal
(pin 3) inside the power connector plug.

3. Connect the Chassis Ground terminal (pin 5) inside the power connector
plug to earth ground. This terminal is internally connected to the C
terminal.

4. (Optional) To power non-FieldDAQ devices through the power network,
connect the leads of an additional auxiliary power source to the Aux1
(pin 4) and Aux2 (pin 2) terminals inside the power connector plug.

5. Assemble the rest of the plug sleeve.

3. Carefully align and connect the cable to the external power source and the
power IN connector on the FieldDAQ device.

4. Turn on the external power source.

If the power source is connected to the power connector using long wiring with high
DC resistance, the voltage at the power connector may be significantly lower than
the specified voltage of the power source.
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Refer to Power Requirements in the FD-11601 Specifications for information
about the power supply input range. Refer to Safety Voltages in the FD-11601
Specifications for information about the maximum voltage from terminal to chassis
ground.

Voltage Input Connectors and Measurements

The following figures show the voltage input circuitry and block diagram of the
FD-11601.

Figure 8. FD-11601 Input Circuitry
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Figure 9. FD-11601 Block Diagram
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The FD-11601 provides channel-to-channel isolation. Input signals on each channel
are conditioned, buffered, and then sampled by an ADC. Each AI channel
provides an independent signal path and ADC, enabling you to sample all
channels simultaneously. The FieldDAQ device provides overvoltage protection for
each channel; refer to the FD-11601 Specifications for more information about
overvoltage protection.

Voltage Input Connectors

The FD-11601 features eight 5-pinA-coded M12 connectors: Bank 1 connectors 0
through 3 and Bank 2 connectors 0 through 3. The following figure shows the pinout
of a voltage input connector.
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Figure 10. FD-11601 Pinout
AI–SP

GND/T–AI+

T+
2

34
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Pin Number Wire Color* Signal Description

1 Brown SP Sensor power
2 White AI- Negative analog input voltage

signal
3 Blue GND/T- Sensor power ground and TEDS

return
4 Black AI+ Positive analog input voltage signal
5 Gray T+ TEDS data
* Wire color pertains to SHM125M I/O cables sold through NI. Other manufacturers' cable wire
colors may vary.

Table 6. Signal Descriptions

Note M12 connectors must be mated to cables or have caps installed on
them to meet IP65/IP67 requirements. Cover the unused connectors with
the included plastic caps whenever water, dust, or dirt are present.

Voltage Input LEDs

Each voltage input connector has an LED.

LED Color and State Connector Status

Off Normal operation, sensor power output disabled, or sensor not present.
Green, solid Sensor power output enabled and sensor connected.
Red, solid Overload. Maximum output current exceeded for the set voltage on sensor

power output.
Yellow, blinking/
alternating

User-defined status. Use MAX to write a state to any LED by expanding
Devices and Interfaces » Network Devices » your FieldDAQ device » bank
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LED Color and State Connector Status
of connectors in your FieldDAQ device and configuring the LED settings
on the Settings tab.

Table 6. LED State/Status

Note When you turn off the LEDs in MAX, the FieldDAQ device controls
and sets the state of the LED. You cannot configure an LED while a task is
running.

Connecting Voltage Input Signals

You can connect grounded and floating voltage input signals to the FieldDAQ device.
Make sure that devices you connect to the FieldDAQ device are compatible, as listed
in the FD-11601 Specifications .

■  Grounded Signal Sources—To ensure proper operation, make sure the
voltage on the AI+ and AI- connections adhere to the channel-to-earth ground
safety voltage specifications listed in the FD-11601 Specifications .
Figure 11. Connecting Grounded Signal Sources to the FieldDAQ Device
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■  Floating Signal Sources

Figure 12. Connecting Floating Signal Sources to the FieldDAQ Device
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Connecting External Sensors

You can power a 3- or 4-wire external sensor with an output voltage range of 5 V
to 24 V by connection through the sensor power (SP) and ground (GND) terminals
on the FieldDAQ device. The output voltage level is configurable using a 10-bit
resolution for maximum flexibility. Use NI software to configure a sensor to turn on
prior to the start of an acquisition.

Figure 13. Powering a 4-Wire External Sensor
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SP1

AI+4
Powered
Sensor

Figure 14. Powering a 3-Wire External Sensor

GND3

AI–2

SP1

AI+4Powered
Sensor

The FieldDAQ device goes into a current limited voltage fold-back mode to protect
the sensor power excitation supply from short circuits or higher current than those
listed in the FD-11601 Specifications . In this mode, the output voltage folds back
to a lower value than the set voltage, the overcurrent status is set in NI-DAQmx, and
the voltage input LED lights red. Removing the overload condition automatically
triggers the output to return to the desired set voltage, the overcurrent status is
cleared in NI-DAQmx, and the voltage input LED returns to normal conditions.

The FieldDAQ device also has an open circuit detection mode to indicate whether
a sensor is connected. For any sensor power output voltage, an open circuit is
detected when the minimum output current for sensor detection is not drawn, as
listed in the FD-11601 Specifications . When an open circuit is detected, the Open
Channel status is set in NI-DAQmx and the voltage input LED turns off.
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If a connected sensor draws a total current below the maximum specifications
values, the voltage input LED lights green.

Connecting TEDS Sensors

You can connect TEDS (Transducer Electronic Data Sheets) sensors to the FieldDAQ
device through the T+ and T- pins on each connector.
Figure 15. Connecting TEDS Sensors to the FieldDAQ Device

TEDS
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Filtering

You can configure a filter for each bank on the FieldDAQ device.[1] The FieldDAQ
device uses hardware filters that include combinations of analog filters and digital
fine tuning to provide highly repeatable responses without the traditional artifacts
of software filtering. The filters are lowpass filters meant to reject (attenuate)
high frequency signals and noise while passing through lower frequency signals.
FieldDAQ supports three types of configurable filter response:

■  Brickwall Filter (default)
■  Butterworth Filter (2nd and 4th order)
■  Comb Filter (5th order)

Each of these three filter responses have different characteristics in how they
attenuate and delay signals. A summary of these characteristics is shown in the
following table.

Attribute Brickwall (Default) Butterworth Comb

Filter Frequency Tracks sample rate Configurable independent
of sample rate

Tracks sample rate

Alias Protection Best—Full protection Depends on ratio of sample
rate to filter frequency

Good—Partial
protection
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Attribute Brickwall (Default) Butterworth Comb
Input Delay Constant input delay

at all frequencies—
Approximately 36 sample
periods

Variable input delay—
Depends on filter setting
(0.4 ms to 5 ms), increases
at higher input frequencies

Constant input delay
at all frequencies
—Approximately 5
sample periods

Step Response
(Time Domain)

Exhibits ringing—
Overshoot and
undershoot

Some overshoot Fastest settling—No
overshoot or
undershoot

Flatness (change
in gain with
input frequency)

Best—Very good flatness
up to 40% of sample rate

Best—Exceptionally flat
below 1/6 (2nd order) or
1/3 (4th order) the filter
frequency

Good—Not Flat

Typical
Applications

Analyzing signals in the
frequency domain

Analyzing dynamic
properties of signals

Analyzing signals in the
time domain

Reducing measurement
noise

Analyzing signals in the
time domain

Measuring fast edges

Table 7. Comparing FieldDAQ Filters

In general, the frequency response of a filter can be described by its attenuation
(magnitude response) and delay (phase response or input delay) of signals at
different frequencies. The step response can be used to illustrate a filter’s resulting
behavior in the time domain.

Frequency Response of FieldDAQ Filters

The FieldDAQ device uses a combination of analog and digital filtering to provide
an accurate representation of in-band signals and reject out-of-band signals. The
filters discriminate between signals based on the frequency range, or bandwidth, of
the signal. How the filter discriminates signals based on their frequency is known
as frequency response. In general, the frequency response of a filter is described by
a signal attenuation (magnitude response) and an input delay (phase response) for
every input frequency.

© National Instruments 23

FD-11601 Feature Usage



■  Magnitude Response—The three important frequency ranges, or
bandwidths, to consider for magnitude response are passband, transition
band, and stopband:
Figure 16. Example Magnitude Response of a Lowpass Filter
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■ Passband—The range of frequencies at which the filter attempts to pass a
signal without modifying it. The small amount of variation in magnitude at
these frequencies is called passband flatness. This is the frequency range of
signals that you want to measure.
■ Transition band—The range of frequencies in which the filter magnitude
response has started to roll-off such that it attenuates signals by some
amount, but has not reached the full attenuation amount. The shape of the
transition band has an impact on the alias rejection and how signals are
represented in the time domain (for example, step response).
■ Stopband—The range of frequencies at which the filter attenuates input
signals to its maximum attenuation level. Ideally, you want to choose a filter
with a stopband that covers frequencies of noise sources that you do not
want in your measurements.

■  Phase Response (Input Delay)—Filters delay the input signal by some
amount when processing data. In some cases, the delay is a function of the
input signal frequency; when this is the case, the phase response plot is useful
for knowing the exact delay at different input frequencies and the maximum
variation between signals of different frequencies within the passband. Call
the AI.FilterDelay property in NI-DAQmx to read the input delay.
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Figure 17. Example Input Delay of a Lowpass Filter
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Each FieldDAQ filter has a different frequency response to serve different
applications:

■  Brickwall—Has a passband that extends to approximately 0.4 times the
sampled data rate, then drops with a very sharp transition band to reach the
stopband and properly reject any alias components or noise that may exist.
The brickwall filter is designed to provide full alias protection from any signal
component of more than one-half the sampled data rate (Nyquist frequency).
■  Butterworth—Has a passband independent of the sampling rate (as
opposed to the brickwall and comb filters), which offers more flexibility
when filtering out noise that is below one-half of the sample rate. However,
depending on your settings, you may see alias components of higher
frequency signals in your measurement that extend beyond one-half of the
sample rate due to the larger transition band.
■  Comb—Has a smaller passband because its transition band starts early in
the frequency range. The comb filter has shorter group delay than other filters
and better representation of signals in the time domain (step response). The
passband and transition band notches track the data sample rate similar to
the brickwall filter. The comb filter's transition band features equally-spaced
notches at different frequencies. It is common to use the comb filter with
a specific sample rate to align the notches of the transition band thereby
removing a specific noise-source frequency from measurements.
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Figure 18. Comparing Typical Magnitude Response of FieldDAQ Filters
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The FieldDAQ filters vary between input delay across signals in the passband:

■  Brickwall—All input frequencies have the same amount of delay when going
through the filter. Choose this filter for applications where linear phase is
required or applications where data correlation between different devices and
configurations is required.
■  Butterworth—Delays signals by a variable amount depending on their
frequency.
■  Comb—All input frequencies have the same amount of delay when going
through the filter. The comb filter has a shorter delay than the brickwall filter.
Choose this filter for applications where linear phase, short delay, or data
correlation of different devices and configurations is required.

Figure 19. Comparing Typical Input Delay for FieldDAQ Filters
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Refer to the FD-11601 Specifications for details on the amount of variation in the
passband gain and signal delay you can expect for different input frequency ranges.

Step Response of FieldDAQ Filters

The shape of the magnitude and phase responses of a filter impacts how signals
look in the time domain. The step response of a filter is typically used to identify the
behavior of a filter in the time domain.

Three important factors of the filter step response are group delay, rise time, and
overshoot/undershoot. The three filters differ instep response across signals in the
transition band:

■  Brickwall—Has the longest group delay. The output signal shows overshoot
and undershoot.
■  Butterworth—Has a shorter group delay and the longest rise time. The
output signal shows overshoot.
■  Comb—Has the shortest group delay and good rise time. The output signal
does not show overshoot or undershoot.

Figure 20. Comparing Typical Step Response of FieldDAQ Filters
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Refer to the FD-11601 Specifications for details on the amount of variation in the
response you can expect for different input frequency ranges.
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Data Rates

You can use the 13.1072 MHz, 12.8 MHz, 12.288 MHz, and 10.24 MHz timebases to
generate data rates. The FD-11601 supports data rates (fs) between 500 Samples/s
and 102.4 kSamples/s. By default, NI-DAQmx automatically chooses the most
suitable timebase for a selected data rate. You can also manually select a timebase
through the NI-DAQmx API. Refer to Timebases in this guide and the FD-11601
Specifications for information about choosing the correct timebase for your data
rate.

Programming the FieldDAQ Device
The following topics provide information about programming analog input
applications and triggers in software for your FieldDAQ device:

■  Configuring Bridge Input Settings
■  Configuring Filter Settings
■  Using Offset Nulling Functions
■  Using Shunt Calibration Functions
■  Configuring Sample Timing
■  Acquiring with a Single NI-DAQmx Task
■  Synchronizing Multiple NI-DAQmx Tasks
■  Using TEDS
■  Timing and Triggering Signals

Configuring Bridge Input Settings

You must configure your FD-11601 for the bridge configuration, excitation, and,
when using quarter bridge configuration, bridge resistance. Use the following
DAQmx properties to configure your bridge sensor.

■  AI.Bridge.Cfg (Channel:Analog Input:General Properties:Signal
Conditioning:Bridge:Configuration)—Allowed values are Full Bridge, Half
Bridge, Quarter Bridge
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■  AI.Excit.Val (Channel:Analog Input:General Properties:Signal
Conditioning:Excitation:Value)—Allowed values are 3.0 (Full, Half, and Quarter
Bridge), 5.0 (Full, Half, and Quarter Bridge), 10.0 (Full and Half Bridge)
■  AI.Excit.Src (Channel:Analog Input:General Properties:Signal
Conditioning:Excitation:Source)—Allowed vlaue is Internal
■  AI.Bridge.NomResistance (Channel:Analog Input:General Properties:Signal
Conditioning:Bridge:Nominal Resistance)—Allowed values are 120, 350

Note You do not need to configure the FD-11601 to use remote sensing.
The FieldDAQ device automatically uses remote sense when the RS+ and
RS- inputs are connected, and local sensing when the RS+ and RS- inputs
are unconnected.

Refer to the Bridge-Based Sensors topic in the NI-DAQmx Help for more
information about configuring and working with bridge-based sensors in NI-DAQmx.

Configuring Filter Settings

You can configure a filter for each bank on the FieldDAQ device.[2] By default,
the FD-11601 uses the Brickwall filter. You can specify Comb or Butterworth filter
responses), as well as the order and cutoff frequency of Butterworth filters. Use the
following DAQmx properties to configure the filters:

■  AI.Filter.Response (Channel:Analog Input:General
Properties:Filter:Response)—Allowed values are Brickwall (default),
Butterworth, Comb.
■  AI.Filter.Order (Channel:Analog Input:General Properties:Filter:Order)—
Allowed values are 2 (Butterworth), 4 (Butterworth), 5 (Comb). This setting
is ignored for Brickwall response.
■  AI.Filter.Freq (Channel:Analog Input:General Properties:Filter:Frequency)—
Range of values for Butterworth filters are 100 to 4096. NI-DAQmx rounds up
to the nearest supported cutoff frequency for the timebase used. Read this
property to get the actual cutoff frequency used:
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■ Brickwall filter—Returns the stopband frequency (one-half the sample
rate)
■ Comb filter—Returns the first notch frequency (equal to the sample rate)

You do not need to specify the filter frequency with Brickwall or Comb
filters. NI-DAQmx returns an error if you specify a frequency higher than the
frequency that would otherwise be returned.

Using Offset Nulling Functions

Use the DAQmx function Perform Bridge Offset Nulling Calibration to perform offset
nulling in Full, Half, and Quarter bridge mode. This function performs software
compensation by taking a reading from the input and subtracting this reading from
all future readings.

The ratiometric reading is stored in the DAQmx property AI.Bridge.InitialRatio
(Channel:Analog Input:General Properties:Signal Conditioning:Bridge:Initial Bridge
Ratio). You can read this property to see the amount of offset that is being nulled.
For best accuracy, ensure that your sensor is in the null or unloaded state and has
had time to reach a steady-state temperature while excited at the desired voltage.

Refer to the Offset Nulling (Bridge Balancing) topic in the NI-DAQmx Help for
more information on performing offset nulling.

Using Shunt Calibration Functions

Use the following DAQmx functions to perform shunt calibration of your sensors:

■  Perform Strain Shunt Cal (for strain channel types)
■  Perform Bridge Shunt Cal (for bridge channel types)—Refer to the Bridge
Measurement Types topic in the NI-DAQmx Help for more information on
measurement types with bridge-based sensors.

Depending on how you configure your channel, you must configure the following:

■  Quarter Bridges—DAQmx uses the internal shunt calibration switch and
shunt resistors and automatically perform the shunt calibration. Configure the
following for your sensor:
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■ Internal shunt resistance—49900 Ω for 350 Ω quarter bridges or 49660 Ω
for 120 Ω quarter bridges
■ Shunt location—Location of R3
■ Shunt source—Default
■ Shunt—Switch A

■  Half and Full Bridges—You will generally get better gain accuracy by using
Remote Sense than by using Shunt Calibration. Refer to Remote Sensing and
Shunt Calibration for more information.
However, you can use the DAQmx Perform Shunt Cal functions with half
bridge and full bridge completion. You must manually apply an external
shunt resistor across the desired bridge resistance before calling the shunt
calibration function and after calling the offset nulling function. When calling
the Perform Strain or Bridge Shunt Cal functions, configure the following for
your sensor:

■ Shunt source—Default
■ Shunt—Switch A
■ Bridge resistance—Resistance of your sensor
■ Shunt resistance—Resistance of your sensor
■ Shunt location—Location of your sensor

Regardless of the bridge configuration used, the DAQmx Perform Shunt Cal
functions measure the shunted bridge or gage and compare this measurement
to the AI.Bridge.InitialRatio value set by the Perform Bridge Offset Nulling
Calibration function. The function then calculates the Correction Factor described
in Remote Sensing and Shunt Calibration, and applies this factor to all
future readings. The correction factor is stored in the NI-DAQmx property
AI.Bridge.ShuntCal.GainAdjust (Channel:Analog Input:General Properties:Signal
Conditioning:Bridge:Shunt Cal:Gain Adjustment). You can read this property to see
the amount of correction being applied as a result of the shunt calibration.

Note You must use the DAQmx Perform Bridge Offset Nulling Calibration
function immediately prior to using the DAQmx Perform Shunt Calibration
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function because the Shunt Calibration uses the result of the Offset Nulling
calibration as the unshunted value.

Directly Programming the Shunt Calibration Switch

With quarter bridge configurations, you may also directly control the internal
shunt calibration resistor by writing to the NI-DAQmx Channel property
AI.Bridge.ShuntCal.Enable (Channel:Analog Input:General Properties:Signal
Conditioning:Bridge:Shunt Cal:Shunt Cal Enable). Writing to this property simple
enables and disables the shunt calibration switch. It does not affect the stored
results of previous offset nulling or shunt calibration functions.

Configuring Sample Timing

You can use the FieldDAQ device in the following analog input applications:

■ Finite acquisition
■ Continuous acquisition

The FieldDAQ device supports the NI-DAQmx Sample Clock timing type. An onboard
clock is dedicated to producing periodic edges to produce each sample. All the
channels on the FieldDAQ device are simultaneously sampled on every sample clock
edge. Refer to the Sample Timing Types topic in the NI-DAQmx Help for more
information on Sample Clock timing and simultaneous sampling.

Acquiring with a Single NI-DAQmx Task

The simplest method for synchronously acquiring multiple channels with DAQmx is
to create a single DAQmx task containing all the channels to be acquired. You can
include channels from multiple FieldDAQ devices in a single task, but they must all
be part of the same IEEE 802.1AS subnet so that they will be synchronized with each
other. All the channels across all devices within the task are sampled simultaneously
with no other programming or trigger necessary.

Even though the channels are sampled simultaneously, the sampled data
represents the signal present at the input terminals at an earlier time due to the

ni.com32

FD-11601 Feature Usage



input delay of the signal through the filtering of the channel. If the channels in
the task have different filter settings or are taken from different FieldDAQ device
models, they can have different input delays. In this case, simultaneously sampled
channels may represent signals at the input terminals at different points in time.
Depending on the needs of your application, you have three options for different
input delays:

■ Ignore the difference in delays
■ Subtract the input delay of each channel from the first sample timestamp
(the t0 component of a waveform) of your acquired waveforms to reflect the
timing of the signals at the input terminals
■ Separate your acquisition into multiple synchronized tasks, as described in
Synchronizing Multiple NI-DAQmx Tasks

Note Refer to Understanding Phase Response (Input Delay) for more
information about the input delay with different filter settings.

Synchronizing Multiple NI-DAQmx Tasks

You can separate your acquisition into multiple NI-DAQmx tasks. All the channels
that you acquire from the same FieldDAQ device must be placed in the same task,
but each task can include the channels from other FieldDAQ devices. Even when
your tasks are running at different sample rates, they all remain synchronized if
all the devices are part of the same IEEE 802.1AS subnet. The tasks containing
FieldDAQ channels are also synchronized with tasks on other IEEE 802.1AS
supported devices, such as TSN-enabled CompactDAQ chassis and CompactRIO
with NI-DAQmx controllers.

The automatic IEEE 802.1AS synchronization of multiple devices on the same TSN
network ensures that once started, the sample rates of your tasks will not drift
relative to each other. To ensure that all the tasks start at the same time, you
provide a time-based trigger to all the tasks.

The simplest method for starting all the tasks at the same point in time is to set
the NI-DAQmx Timing property FirstSampClk.When (Timing:Advanced:First Sample
Clock Time:When). NI-DAQmx configures the necessary timing and triggering signals
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to ensure that the first sample clock on every device occurs simultaneously at the
time you write to this property.

Even though the channels are all sampled simultaneously, the sampled data
represents the signal present at the input terminals at an earlier time due to the
input delay of the signal through the filtering of the channel. You can adjust the
timing of each task to account for a fixed amount of input delay by writing to
the NI-DAQmx Timing property FirstSampClk.Offset (Timing:Advanced:First Sample
Clock Time:Offset). NI-DAQmx configures all devices in a task to delay the sampling
by the amount written to this property. If all the channels in a task are configured
such that they have the same input delay, writing the value of this delay
to the FirstSampClk.Offset property ensures that the first sampled data point
represents the signal at the input terminals at the precise time specified in the
FirstSampClk.When property.

Refer to Understanding Phase Response (Input Delay) for more information about
the input delay with different filter settings. Refer to Time-Based Triggers for more
information about how TSN devices share a notion of time that can be used for
setting trigger events.

Using TEDS

A TEDS can reside in embedded memory, typically an EEPROM, within the sensor.
You can download a TEDS from the sensor with the FieldDAQ device. You can then
download the TEDS in MAX to use in your application.

With MAX, you can use the Configure TEDS window to add and remove transducer
electronic data sheet (TEDS)-compatible sensors from your FieldDAQ device.

■  Scan for TEDS—Use to detect TEDS-compatible sensors. For each channel
connected to a detected sensor, TEDS Capable Sensor appears in the
corresponding TEDS Information column. Select a device channel.
■  Import Virtual TEDS—Use to select a .ted file. After the file loads, TEDS
Capable Sensor appears in the corresponding TEDS Information column.

Use the DAQmx Write TEDS Data (U8 Array) function to write TEDS data from a
1D array of 8-bit unsigned integers to the TEDS sensor connected to the physical
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channel you specify. The TEDS data must be in a bitstream constructed according to
the IEEE 1451.4 specification.

Some TEDS sensors include a PROM, to which you can write data one time. When
you write TEDS data, you can choose to write basic TEDS data to the PROM or to
the EEPROM. Basic TEDS data includes the manufacturer ID, model number, serial
number, version number, and version letter. If you write basic TEDS data to the
PROM, the Write TEDS Data function returns an error if you later attempt to write
basic TEDS data to the EEPROM.

Timing and Triggering Signals

The FieldDAQ device features the following timing and triggering signals:

■  AI Sample Clock Signal
■  AI Sample Clock Timebase Signal
■  AI Start Trigger Signal
■  Analog Input Sync Pulse

AI Sample Clock Timebase Signal

The FD-11601 generates four measurement timebases, with frequencies of
13.1072 MHz, 12.8 MHz, 12.288 MHz, and 10.24 MHz. Any of these timebases can
be selected as the AI Sample Clock Timebase. The AI Sample Clock Timebase signal
is divided down to provide a source for the AI Sample Clock. Refer to the FD-11601
Specifications for a table of possible sample rates for each of the four timebases.
By default, NI-DAQmx automatically chooses the most suitable timebase for a
selected data rate. You can also manually select a timebase through the NI-DAQmx
API, using the NI-DAQmx property SampleClock.Timebase.Source (Timing:Sample
Clock:Timebase:Source).

The 13.1072 MHz, 12.8 MHz, 12.288 MHz, and 10.24 MHz timebases are all
synchronized to each other and are automatically synchronized to other network-
synchronized devices that are part of your local IEEE 802.1AS subnet. This enables
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measurement signals to be synchronized to other devices across a distributed
network.

Figure 21. AI Sample Clock Timebase Options
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The FD-11601 also generates an 80 MHz and 20 MHz timebase that are used with
internal counters in the device. The 80 MHz and 20 MHz timebases are not available
for use as the AI Sample Clock Timebase.

AI Sample Clock Signal

A sample consists of one reading from each channel in the AI task. Sample Clock
signals the start of a sample of all analog input channels in the task. Refer to the
following figure for sample clock source options.

Figure 22. AI Sample Clock Timing Options
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The FD-11601 is considered a Delta-Sigma device; it contains multiple A/D
converters that require a high-frequency oversample clock to produce accurate,
synchronized data. The FieldDAQ device returns a sample on every Sample Clock
pulse.

The oversample clock is used as the AI Sample Clock Timebase. The FieldDAQ
device supplies 13.1072 MHz, 12.8 MHz, 12.288 MHz, and 10.24 MHz timebases. By
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default, NI-DAQmx automatically chooses the most suitable timebase for a selected
data rate.

The FieldDAQ device automatically issues a synchronization pulse to each bank that
resets their ADCs at the same time. You can also specify a specific time for the
synchronization pulse to occur. Because of the filtering used in the Delta-Sigma
FieldDAQ device A/D converters, these devices exhibit a fixed input delay relative to
non-Delta-Sigma devices in the system. This input delay is specified in the FD-11601
Specifications .

When using multiple FieldDAQ devices in a task that contains channels for a Delta-
Sigma device, such as the FD-11601, ensure that one of those channels is the first in
your channel list.

AI Start Trigger Signal

Use the Start Trigger signal to begin a measurement acquisition. After the
AI Start Trigger signal, the AI Sample Clock begins on the next available time interval
according to the equation given above in the description of the Synchronization
Pulse. Since the AI Sample Clock occurs at precise timing intervals referenced to the
sync pulse and spaced apart by the sample period, the first AI Sample Clock event
may occur up to one sample period after the AI Start Trigger. You may not specify an
AI Start Trigger to occur more than one sample period before the first available time
for an AI Sample Clock; this means that the AI Start Trigger must be configured to
occur at least the reset time after the sync pulse.

Figure 23. Relationship of Timing and Triggering Signals

Sync Pulse

AI Start Trigger
Reset Time

Ts Ts
Earliest Possible AI Sample Clock

Earliest Allowed Time for AI Start Trigger

1st AI Sample Clock

1st Returned Sampled Data Point

AI Sample Clock

Input Signal

Input Delay

© National Instruments 37

FD-11601 Feature Usage



You can configure the Start Trigger signal to occur at a specific time by writing to the
DAQmx property Start.Time.When (Trigger:Start:Time:When). Refer to Time-Based
Triggers for more information about specifying time events.

Analog Input Sync Pulse

The Analog Input Sync Pulse resets the internal generation of the Sample Clock
signal. Sample Clocks will be generated after a reset time which depends on the
Sample Clock Rate and the filter settings. You can read the value of this reset
time with the DAQmx property SyncPulse.ResetTime (Timing:More:Synchronization
Pulse:Reset Time). Since the filter delay depends on filter and sample rate settings,
you must configure your DAQmx task with the sample rate and filter settings before
reading the reset time property.

Sample clocks are available precisely after the analog input synchronization pulse
at times equal to SyncPulse.ResetTime + (n × TS) where TS is the sample period
(1/Sample Clock Rate) and n is any integer greater than or equal to 1.

The actual time of the first AI Sample Clock is determined by the AI Start Trigger
signal. Refer to the following figure for an illustration of the reset time and sync
pulse operation.

Figure 24. Relationship of Timing and Triggering Signals
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You can configure the synchronization pulse to occur at a specific time by
writing to the DAQmx property SyncPulse.Time.When (Timing:More:Synchronization
Pulse:Time:When). Refer to Time-Based Triggers for more information about
specifying time events.
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Time-Based Triggers

TSN enabled devices can take advantage of time-based synchronization features in
NI-DAQmx. Certain triggers can be specified in terms of time of day. Time-based
triggers and multidevice tasks (spanning multiple network-synchronized FieldDAQ
and other TSN enabled devices) can help simplify programming for large systems.

The simplest method to trigger a task based on time is to use the NI-DAQmx
property FirstSampClk.When (Advanced:First Sample Clock Time:When), and
optionally the NI-DAQmx property FirstSampClk.Offset (Advanced:First Sample
Clock Time:Offset). Refer to Synchronizing Multiple NI-DAqmx Tasks for details on
the use of these properties.

You can also directly set the times at which the Analog Input Synchronization Pulse
and the AI Start Trigger occur by setting the following NI-DAQmx properties:

■  SyncPulse.Type (Timing:More:Synchronization Pulse:Type)—Allowed value
is Time.
■  SyncPulse.Time.Timescale (Timing:More:Synchronization
Pulse:Time:Timescale)—Set as described below.
■  SyncPulse.Time.When (Timing:More:Synchronization Pulse:Time:When)—
Set to the time you want the Synchronization Pulse to occur.
■  Start.TrigType (Trigger:Start:Trigger Type)—Allowed value is Time.
■  Start.Time.Timescale (Trigger:Start:Time:Timescale)—Set as described
below.
■  Start.Time.When (Trigger;Start:Time:When)—Set to the time you want the
Start Trigger to occur.

You can also configure the Start Trigger time using the Start Time instance of the
DAQmx Trigger node in LabVIEW, or the DAQmxCfgTimeStartTrig function in C.

Note You must set the start trigger to occur after the synchronization
pulse by at least the reset time, ss described in AI Start Trigger Signal.
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Time triggers can be specified in Host Time or I/O Device Time, depending on the
needs of your application.

■  I/O Device Time—The time the FieldDAQ device uses internally. This
time is determined by the network configuration and is shared by all
IEEE 802.1ASnetwork-synchronized devices on your subnet.
■  Host Time—The time on your Windows computer or NI Linux Real-Time
controller. This is usually the current global time and is provided by a local
real-time clock or a network time protocol (NTP) server.

NI-DAQmx automatically translates from Host Time to I/O Device Time as necessary.
The accuracy of this translation depends on the relationship between these times
and can reduce the relative accuracy of time triggers across multiple devices. For
maximum accuracy, use an NI LinuxReal-Time controller as the host in a supported
topology. However, NI-DAQmx guarantees that two tasks configured to start at the
same host time always start at the same I/O Device Time in all scenarios, preserving
precise synchronization between chassis in this common use case. Refer to the
Time Triggering topic in the NI-DAQmx Help for more information on accessing
time-based features in the NI-DAQmx API.

Timebases

The following figure shows the FD-11601 clock routing circuitry and timebases.

Figure 1. Clock Routing Circuitry
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You can use the 13.1072 MHz, 12.8 MHz, 12.288 MHz, and 10.24 MHz timebases to
generate the AI Sample Clock signals. These timebases are generated directly from
the onboard clock generator. By default, NI-DAQmx automatically chooses the most
suitable timebase for a selected data rate. You can also manually select a timebase
through the NI-DAQmx API.
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Refer to the FieldDAQ Timing Considerations and Master Timebase
Synchronization topics in the NI-DAQmx Help for more information about
configuring timing in the NI-DAQmx API.

Synchronization across a Network
FieldDAQ devices feature automatic network-based synchronization with
compatible networks and IEEE 802.1AS-capable NI Linux Real-Time controllers.
The SYNC logo on the device front panel indicates that the device is capable of
hardware-based synchronization over a network, whether daisy-chained together
or connected to external networks that support IEEE 802.1AS synchronization. For
more information about supported topologies and other technical requirements,
refer to Topology Options.

The clock generator illustrated in AI Sample Clock Timebase Signal automatically
synchronizes to other network-synchronized devices that are part of your local
IEEE 802.1AS subnet. The 13.1072 MHz, 12.8 MHz, 12.288 MHz, and 10.24 MHz
timebases are derived from the oscillator, and are synchronized to it. Therefore,
they are also synchronized to other network-synchronized timebases on your
IEEE 802.1AS subnet. This enables measurement signals to be synchronized to other
devices across a distributed network.

While the simplest method of synchronizing FieldDAQ devices over a network is
to use the default IEEE 802.1AS protocol, the FieldDAQ devices can optionally be
configured to use the IEEE 1588 "Delay Request-Response Default PTP" profile
instead. The FieldDAQ devices do not support synchronizing with other 1588
profiles. For an example of synchronizing with this IEEE 1588 profile, see the tutorial
“Synchronizing FieldDAQ and TSN-Enabled Ethernet cDAQ Chassis to a PXI System”
by visiting ni.com/info and entering fd1588.

More Information about Synchronization
The following documents will help you overcome typical hurdles in getting started
with synchronized measurements:
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■  Synchronizing analog input FieldDAQ devices with NI-DAQmx in LabVIEW
—Visit ni.com/info and enter fdaisync.
■  Designing Ethernet measurement systems for synchronization, considering

topologies, masters, and third party devices—If topology changes result in a
device’s master changing, executing tasks may be affected. Visit ni.com/info
and enter fdenet.
■  How to achieve high accuracy measurements—Visit ni.com/info and enter
fdsync.
■  Synchronization accuracy explained—Visit ni.com/info and enter syncacc.
■  Synchronizing FieldDAQ and TSN-Enabled Ethernet cDAQ Chassis to a

PXI System—Visit ni.com/info and enter fd1588.

Ethernet Ports and Networking

The Ethernet Network Interface transfers data between the FieldDAQ device and the
network. It gathers the data into TCP/IP packets that can be sent across the network
and interpreted by the host.

Note Refer to Setting up the FieldDAQ Device or Connecting to a Real-
Time Controller for information about connecting the FieldDAQ device to a
host computer or host real-time controller.

Ethernet Ports

The FieldDAQ device has two 8-pinX-coded M12 Ethernet ports—0 and 1. You
can use a shielded straight-through Ethernet or an Ethernet crossover cable with
either of the Ethernet ports to network your device to a computer host, NI Linux
Real-Time controller, another FieldDAQ device, or any network connection on the
same subnet. Refer to Topology Options for more information about using these
ports in various topologies.
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Figure 26. Ethernet Connector Pinout
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Pin Number Wire Color Gigabit Ethernet Signal Fast Ethernet Signal

1 Orange/White BI_DA+ TX+
2 Orange BI_DA- TX-
3 Green/White BI_DB+ RX+
4 Green BI_DB- RX-
5 Brown/White BI_DD+ No Connect
6 Brown BI_DD- No Connect
7 Blue/White BI_DC+ No Connect
8 Blue BI_DC- No Connect

Table 8. Signal Descriptions

You can use the Ethernet ports to reset the FieldDAQ device to factory-default
settings. Refer to Resetting the FieldDAQ to Factory-Default Settings for more
information.

Cap the Ethernet ports when not in use.

Ethernet LEDs

Each Ethernet port has a green LED that indicates network activity and link speed.

LED State Device Status

On Ethernet link
Blinking, fast (12 blinks/s) Ethernet activity. Connected at 1,000 Mbit/s.
Blinking, moderate (6 blinks/s) Ethernet activity. Connected at 100 Mbit/s.
Blinking, slow (3 blinks/s) Ethernet activity. Connected at 10 Mbit/s.
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LED State Device Status
Off No Ethernet connection

Table 11. LED State/Device Status

Internal Ethernet Switch

The FieldDAQ device features a full hardware-accelerated internal Ethernet switch
for greater performance, wiring flexibility, and compatibility over standard Ethernet
ports. The Ethernet switch exposes two Ethernet ports to the user. Either port
can be used to connect the device to the network. The two ports can be used to
connect multiple devices in a daisy-chain topology. The switch also supports the
Rapid Spanning Tree Protocol (RSTP) algorithm, enabling ring topologies. Refer to
Topology Options for more details.

IEEE 802.1AS-2011 Precision Time Protocol

The internal Ethernet switch is an IEEE 802.1AStime-aware bridge, compatible
with the IEEE 802.1AS-2011 Precision Time Protocol. It can synchronize local
measurement signals to other devices across an IEEE 802.1AS subnet. It can also
serve as a bridge, synchronizing IEEE 802.1AS devices that are attached to each of
the two ports. Refer to Synchronization across a Network for more details.

IEEE 802.1Q Rapid Spanning Tree Protocol (RSTP)

It is possible to create loops in a network using the FieldDAQ device. To prevent
these loops from disrupting the network, the FieldDAQ device implements the
IEEE 802.1Q Rapid Spanning Tree Protocol (RSTP). Using this protocol, each
FieldDAQ device can find the shortest path for incoming packets to reach the rest
of the network. When multiple paths exist, this adds a form of redundancy. If a link
fails, the protocol automatically switches to use the redundant link. This process
can take several seconds in some cases.

To gain these benefits on external switches connected to the FieldDAQ device,
IEEE 802.1Q (RSTP) must be enabled. All external switches must be configured to
allow the FieldDAQ device to transmit RSTP packets, known as Bridge Protocol Data
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Units (BPDU). If any switch has a feature—such as “BPDU guard”—enabled, the port
connected to the FieldDAQ device is disabled and communication is lost. Refer to
the documentation for your external switch for information about enabling RSTP
and disabling BPDU guards on the switch.

IEEE 1588-2008 Protocol

The internal Ethernet switch can be configured to act as a 1588 "boundary clock"
implementing the IEEE 1588 delay request-response default PTP profile (sometimes
referred to as "default profile"). When so configured, it can synchronize local
measurement signals to other devices across an IP subnetwork and can serve as
a bridge, synchronizing 1588 devices that are attached to each of the two ports.
Refer to Synchronization across a Network for more details.

Note The IEEE 802.1AS protocol is an IEEE 1588 profile, but is
incompatible with other IEEE 1588 profiles. When FieldDAQ devices are
using the IEEE 802.1AS protocol to synchronize they cannot synchronize
with devices that use other protocols or IEEE 1588 profiles and vice versa.

FieldDAQ MAC Addresses

The FieldDAQ device is associated with two MAC addresses—both of which are
labeled on the device—device and switch. These MAC addresses are not associated
with a particular Ethernet port, but both addresses can appear on both ports as
necessary.

Device MAC Address Switch MAC Address

Associated with the device's IP
address

Associated with the internal Ethernet switch—not
associated with the device’s IP address

Used by normal device traffic Used for Ethernet protocols for network configuration and
synchronization

Listed in MAX Not listed in MAX

Table 10. NI MAX Device and Switch MAC Addresses
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The switch MAC address is used to implement the following switch protocols:

■  IEEE 802.1AS-2011 (Precision Time Protocol)
■  IEEE 802.1Q (Rapid Spanning Tree Protocol [RSTP])
■  IEEE 1588-2008 (Precision Time Protocol)

The switch MAC address only appears in packets exchanged between the switch
embedded in the FieldDAQ device and the next Ethernet device. It will not
propagate further in a properly configured network. For more information about the
recommended configurations for networking the FieldDAQ device, refer to Topology
Options.

Topology Options
Recommended networking topologies are described in this section.

■  Host—Can be a Windows computer or a real-time controller with the
NI Linux Real-Time operating system, such as the IC-317x, cRIO-9035/9039
Sync, cRIO-904x/905x, or cDAQ-9132/9133/9134/9135/9136/9137 for LabVIEW
Real-Time
■  Node—Can be any FieldDAQ device or IEEE 802.1AS-compliant
CompactDAQ chassis, such as the cDAQ-9185/9189

For more information about designing Ethernet measurement systems, visit ni.com/
info and enter fdenet.

Line Topology

In a line topology—also known as daisy-chaining or bus topology—the host
communicates directly with all nodes through one bus line. A standard Ethernet
device or switch can be added to the end of the chain if desired and used as normal.
Be aware that these devices will compete for network bandwidth with the FieldDAQ
device. Reliable system design requires awareness of the bandwidth consumed by
each device during operations. This topology offers no redundant links.
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Figure 27. Line Topology

Networking

Node Node NodeHost

Advantages:

■ Simple and inexpensive installation, expansion, and troubleshooting
■ Ideal for low number of nodes. NI recommends a maximum of 15 nodes.
■ No external switch needed
■ Can cover long distances

Disadvantages:

■ Any unpowered nodes and/or node failure disrupts network communication
■ Addition or removal of any node disrupts network communication
■ Failure of any Ethernet cable and/or improper cable termination disrupts
network communication
■  Network performance and synchronization affected when node count
exceeds 15. Consider the Star Topology for systems that require a greater
number of nodes.

Note For information about daisy-chaining power, refer to Power
Connectors and Wiring.

Ring Topology

In a ring topology, the host communicates with all nodes through the most effective
path. You must use an external switch in a ring topology. You must configure the
network properly with a recommended external switch before creating redundant
links in the network. Refer to External Switch Requirements for information about
what to look for in an external switch.
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Figure 28. Ring Topology
Node Node Node

Networking

Host

External
Switch

Advantages:

■ Failure of any single Ethernet cable does not disrupt network
communication
■ Additional nodes or heavier network traffic affects network performance
less than the line topology
■ Simple installation
■ Ideal for a local networking solution

Note Network configuration and programming require careful
consideration. Visit ni.com/info and enter fdenet for information about
exploiting link redundancy and automatically improving reliability.

Disadvantages:

■ Network traffic patterns can make troubleshooting difficult
■ Requires an external switch

Note For information about daisy-chaining power, refer to Power
Connectors and Wiring.

Star Topology

In a star topology, the host communicates directly with each node through the
external switch. You must use an external switch in a star topology; for network
synchronization, you must use an external IEEE 802.1AS switch. Redundant links
are recommended, but optional, in this topology. You must configure the network
properly with a recommended external switch before creating redundant links in
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the network. Refer to External Switch Requirements for information about what to
look for in an external IEEE 802.1AS switch.

Figure 29. Star Topology

Node

Node

Node

Host

Networking
Redundant Link (optional)

External
Switch

Advantages:

■ Unpowered nodes and/or node failure does not disrupt network
communication with other nodes
■ Failure of any single Ethernet cable does not disrupt network
communication when you have a redundant link
■ Additional nodes or heavier network traffic affects network performance
less than the other topologies
■ Simple installation, expansion, and troubleshooting

Note Network configuration and programming require careful
consideration. Visit ni.com/info and enter fdenet for information about
exploiting link redundancy and automatically improving reliability.

Disadvantages:

■ Most costly of the recommended topologies
■ Requires an external switch (external IEEE 802.1AS switch for network
synchronization)
■ Covers the least distance
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Note For information about daisy-chaining power, refer to Power
Connectors and Wiring.

Other Topologies

For information about designing Ethernet measurement systems for
synchronization, visit ni.com/info and enter fdenet.

External Switch Requirements

To meet the minimum requirements for successful operation with FieldDAQ devices,
any switch directly connected to the FieldDAQ device should be compliant with
IEEE 802.1Q bridges and bridged networks.

To take advantage of the network synchronization and network redundancy
features of the FieldDAQ device, ensure that your network infrastructure meets
certain requirements:

■  IEEE 802.1AS-2011 time-based synchronization support—Automatically
synchronizes timebases and enables the use of time-based triggers and
multi-device tasks between device across the network.
■  IEEE 802.1Q (Rapid Spanning Tree Protocol) support—Supports network
redundancy functionality in ring and star topologies

■ Rapid Spanning Tree Protocol (RSTP) enabled
■ Bridge Protocol Data Units (BPDU) Guard disabled

To learn more about recommended network switches and other network
configuration best practices and requirements, visit ni.com/info and enter fdenet.

Connecting to a Real-Time Controller
You can use the FieldDAQ device as expansion I/O from certain NI Linux Real-Time
controllers. Discover and configure the NI Linux Real-Time controller in NI MAX, then
discover and configure the FieldDAQ device.
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Note When using an NI Real-Time controller as the host, you can
only use select controllers with the NI Linux Real-Time operating
system that support NI-DAQmx. Supported NI Linux Real-Time
controllers include the IC-317x, cRIO-9035/9039 Sync, cRIO-904x/905x,
and cDAQ-9132/9133/9134/9135/9136/9137 for LabVIEW Real-Time.[3]

To network the FieldDAQ device to a Real-Time controller, you need the following
items.
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Figure 1. FieldDAQ Installation Supply List
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1. Host Computer
2. Supported Real-Time Controller
3. LabVIEW Software, if not already installed
4. LabVIEW Real-Time Module, if not already installed
5. Driver for the Real-Time Controller, if not already installed
6. NI-DAQmx Driver, if not already installed
7. FieldDAQ Device
8. 5-pin L-coded M12 Power Input Cable
9. 8-pin X-coded M12 Ethernet Cable

10. External Power Supply
11. 5-pin A-coded M12 I/O Cables and Accessories

Note LabVIEW Real-Time 2017 or later required to use the FieldDAQ
synchronization features.

Note You can either use a shielded straight-through Ethernet cable or an
Ethernet crossover cable to connect the FieldDAQ device directly to your
computer.
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Complete the following steps.

1. Install the LabVIEW, LabVIEW Real-Time Module, and controller driver
software on the host machine as instructed in the getting started or quick
start document for the Real-Time controller.

2. Install NI-DAQmx on the host machine if the driver was not installed in step 1.

1. Download NI-DAQmx from ni.com/downloads/drivers. Complete the
instructions.

2. Register your NI hardware online at ni.com/register when prompted.
3. Download NI-DAQmx to the target using MAX. Refer to the MAX Remote

Systems Help by selecting Help » Help Topics » Remote Systems in
MAX.
If you have problems installing your software, go to ni.com/support/
daqmx.

3. Set up your Real-Time controller hardware and install software to it as
instructed in the getting started or quick start document for the Real-Time
controller.

4. For CompactRIO and IC controllers, perform a custom installation of the
NI-DAQmx feature to the controller. In MAX, expand Remote Systems » your
Real-Time Controller, and use the Add/Remove Software option. Select
the custom installation option and the NI-DAQmx feature, then follow the
prompts to complete the installation.

5. Make signal connections for your application.
6. Align and connect one end of the Ethernet cable to Ethernet port 0 on the

FieldDAQ device, and the other end to a switch or network connection on the
same subnet as your Real-Time controller, or directly to an open network port
on your Real-Time controller. For more information about the recommended
configurations for networking the FieldDAQ device in a Real-Time system,
refer to Topology Options.

7. Power the device by aligning and connecting the power IN port on FieldDAQ7.
to an external 9 V DC to 30 V DC power source with the 5-pinL-coded M12
power cable. For information about wiring your external power source to
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the power connector, refer to Wiring External Power to the FieldDAQ Device.
The FieldDAQ device requires an external power supply that meets the
specifications listed in the FD-11601 Specifications .

The Power LED turns on. Refer to Power LED for information about Power LED
status.

8. To add the FieldDAQ to the software configuration on the Real-Time target,
open NI MAX on the host computer. In the MAX configuration tree, expand
Remote Systems » your Real-Time Controller » Devices and Interfaces »
Network Devices.

9. Click Add Network Device, and then Find Network NI-DAQmx Devices.
10. In the Find Network NI-DAQmx Devices dialog box that opens, do one of the

following:

■  Check the box that corresponds to your device in the Hostname column.
■ If you know the device IP address, such as 192.168.0.2, enter it into the
Add Device Manually field of the Find Network NI-DAQmx Devices window,
and click the + button.
■ Enter the hostname of the device. The default hostname is FD11601-
<serial number>.

If your FieldDAQ device does not appear in Available Devices, click Refresh

List. If the device still does not appear, contact your system administrator to
confirm that the network is working and that a firewall is not interfering with
discovery. For additional troubleshooting resources for the FieldDAQ device,
refer to Troubleshooting Device Connectivity in this guide and the Finding
a Network DAQ Device in MAX topic in the Measurement & Automation
Explorer Help for NI-DAQmx.

11. Click Add Selected Devices. The FieldDAQ device is added under the Real-11.
Time controller in the MAX configuration tree.
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Figure 31. Adding the FieldDAQ Device to the Real-Time Controller in MAX

12. If the FieldDAQ device is not reserved automatically, select the device and
click the Reserve Network Device button. Refer to Reserving the Device in
MAX for more information.

13. Self-test your device in MAX by expanding Devices and Interfaces » Network

Devices, right-clicking your FieldDAQ device, and selecting Self-Test. Self-test
performs a brief test to determine successful device installation. When the
self-test finishes, a message indicates successful verification or if an error
occurred. If an error occurs, refer to ni.com/support/daqmx.

14. Run a Test Panel in MAX by expanding Devices and Interfaces » Network

Devices » your FieldDAQ device, right-clicking the bank of connectors in your
FieldDAQ device, and selecting Test Panels. If the test panel displays an error
message, refer to ni.com/support. Click Close to exit the test panel.

Note When in use, the FieldDAQ device may become warm to the touch.
This is normal.

Note M12 connectors must be mated to cables or have caps installed on
them to meet IP65/IP67 requirements. Cover the unused connectors with
the included plastic caps whenever water, dust, or dirt are present.
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Note Avoid long periods of exposure to sunlight.

Troubleshooting Device Connectivity

If your FieldDAQ device becomes disconnected from the network, open MAX and try
the following:

■ After moving the device to a new network, NI-DAQmx may lose connection
to the device. In this case, click Reconnect to provide NI-DAQmx with the new
hostname or IP address.
■ The FieldDAQ device icon indicates whether it is recognized and present
on the network. If a connected device appears as disconnected in the
configuration tree in MAX, select Self-Test or Reset. If successful, the device
icon changes to dark grey.

Figure 32. MAX Icons and States

21 3

1. Discovered, but Not Added to the Network
2. Recognized, Present, and Reserved on the Network
3. Recognized, but Disconnected from the Network, Unreserved, or Reserved by

Another Host

For additional troubleshooting resources for the FieldDAQ device, refer to the
Finding a Network DAQ Device in MAX topic in the Measurement & Automation
Explorer Help for NI-DAQmx.

Reserving the Device in MAX

When the FieldDAQ device is connected to a network, multiple users can access
the device. To perform any DAQ functionality on the device, including reset and
self-test, you must reserve the device in MAX. In MAX, an unreserved device or device
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reserved by another host appears with an X and a reserved device appears as dark
grey. Only one user at a time can reserve the FieldDAQ device.

If the device was not reserved automatically after it was added (Add Device), you
can reserve the device in MAX by expanding Devices and Interfaces » Network

Devices, selecting the device, and clicking the Reserve Network Device button.
The Override Reservation dialog box opens when you attempt to explicitly reserve
a device. Agreeing to override the reservation forces the FieldDAQ device to be
reserved by the current user.

STATUS LED

The FieldDAQ device has a STATUS LED.

LED Color and
State

Device Status

Off Device is reserved by NI-DAQmx but there is no activity, the device is not
powered, or the device is not reserved by NI-DAQmx.

Yellow, solid Device firmware is booting or updating.
Red, blinking Device has reset to factory default or the firmware image is corrupted. If you

are not performing a factory default reset, as listed in Resetting the FieldDAQ
to Factory-Default Settings, contact NI for support on corrupted firmware.

Green, solid Device is reserved and an NI-DAQmx task is running.

Table 11. LED State/Device Status

Resetting the FieldDAQ to Factory-Default Settings

To reset your FieldDAQ device to factory-default settings, complete the following
steps.

1. Verify the power source is turned off.
2. Connect Ethernet port 0 and port 1 with an Ethernet cable.2.
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Figure 33. Connecting Port 0 and Port 1
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3. Turn on the power source to the device. After about 15 seconds, the STATUS
LED blinks red indicating that the device has been restored to factory-default
settings.

4. Reconnect the Ethernet port 0 to the host.
5. Turn off and then turn on the power source to the device.

The FieldDAQ device factory-set defaults are listed in the following table.

Attribute Value

Hostname FD11601-<serial number>
IP DHCP or Link Local
Comment Empty
Default login User name = admin

Password = no password required

Table 12. Device Default Settings

Mounting

FieldDAQ can be mounted on any substrate in any orientation if the ambient
temperature is 75 °C or less. However, to ensure proper functionality during use
above 75 °C, you must mount the FieldDAQ device in the reference mounting
configuration shown in the following figure. Observe the following guidelines to
mount the FieldDAQ device in the reference mounting configuration.
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Figure 34. Reference Mounting Configuration
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1. Vertical mounting orientation.
2. Mount the FieldDAQ device directly to a metallic surface that is at least 1.6 mm

(0.062 in.) thick and extends a minimum of 76.2 mm (3 in.) beyond all edges of
the device.

3. Observe the cooling dimensions in Mounting Requirements.
4. Allow space for cabling clearance according to the Mounting Requirements.

Before using any mounting methods, record the serial number from the back of the
FieldDAQ device so that you can identify it in MAX. You will be unable to read the
serial number after you mount the device.
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Mounting Requirements

Your installation must meet the following requirements for cooling and cabling
clearance. Allow 76.2 mm (3.00 in.) on all sides of the device for air circulation, as
shown in the following figure.

Figure 35. Cooling Dimensions
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Allow the appropriate space in front of the device for cabling clearance, as shown in
the following figure.

Figure 36. Cabling Clearance

Cabling
Clearance
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Measure the ambient temperature at each side of the FieldDAQ device, 76.2 mm
(3.00 in.) from the side and 25.4 mm (1.00 in.) forward from the rear of the device.
Refer to the following figures for ambient temperature locations for horizontal and
vertical mounting configurations.

Figure 37. Ambient Temperature Locations, Horizontal Mounting Configuration
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Figure 38. Ambient Temperature Locations, Vertical Mounting Configuration
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Dimensions

For detailed dimensional drawings and 3D models, visit ni.com/dimensions and
search for FD-11601.

Mounting the Device Directly on a Flat Surface

For environments with high shock and vibration, NI recommends mounting the
FieldDAQ device directly on a flat, rigid surface using the mounting holes on the
device. This mounting technique requires four M5 or 10-32 panhead or sockethead
cap screws appropriate for the surface.

Complete the following steps to mount the FieldDAQ device directly on a flat
surface.

1. Prepare the surface for mounting the device using the surface mounting
dimensions.
Figure 39. Surface Mounting Dimensions
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184.0 mm
(7.24 in.)

2. Align the device on the surface.
3. Fasten the device to the surface using the M5 or 10-32 screws. Tighten the

screws to a maximum torque of 2.5 N · m (25.0 lb · in.).
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Figure 40. Fastening the Device to the Surface
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Alternate Mounting Configurations

The maximum operating temperature of 85 °C may be reduced for any mounting
configuration other than the reference mounting configuration. A 10 °C (18 °F)
reduction in maximum operating temperature is sufficient for most alternate
mounting configurations. Follow the mounting requirements for all mounting
configurations.

The published accuracy specifications, although not guaranteed for alternate
mounting configurations, may be met depending on the system power and the
thermal performance of the alternate mounting configuration.

Contact NI for further details regarding the impact of common alternate mounting
configurations on maximum operating temperature and accuracy.

Mounting the Device on a DIN Rail

The FD-11960 DIN rail mounting kit is an accessory you can use to mount a FieldDAQ
device to a DIN rail. The hardware in the FD-11960 DIN rail mounting kit includes a
bracket panel, a DIN rail clip, four M5 x 10 mm screws, four M5 washers, and two
8-32 x 1/4 in. screws.
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Complete the following steps to install a FieldDAQ device onto a DIN rail using the
FD-11960 DIN rail mounting kit.

1. Attach the FieldDAQ device to the bracket panel using the included M5 x 10
mm screws and M5 washers. The front of the bracket panel, which includes
an outline of the FieldDAQ device, should be attached to the back of the
FieldDAQ device.

2. Attach the DIN rail clip to the FieldDAQ device and bracket panel using the
8-32 x 1/4 in. screws included in the kit. Tighten the screws to a maximum
torque of 1.3 N · m (11.5 lb · in.).
Figure 41. Attaching a FieldDAQ Device to the Bracket and DIN Rail Clip
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1. Bracket panel
2. DIN rail clip
3. M5 x 10 mm screw
4. 8-32 x 1/4 in. screw
5. M5 washers
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Note You can also horizontally mount the FieldDAQ device to the
DIN rail.

3. Clip the device onto the DIN rail.
Figure 42. DIN Rail Clip Parts Locator
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2. DIN rail spring
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Figure 43. FD-11960 Dimensions
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Calibration

The FD-11601 can be verified and adjusted. Refer to the FD-11601 Calibration
Procedure for a detailed calibration procedure. Ensure that your driver software is
updated to a version that supports calibration for your FieldDAQ device.

Driver Earliest Version Support

NI-DAQmx 19.0

Table 13. FD-11601 Calibration Driver Support

Firmware

Firmware can be updated through NI MAX or the web interface to the device. For
FieldDAQ firmware information and updates, visit ni.com/info and enter the Info
Code fdfw.

Maintenance

If you need to clean your device, wipe it with a dry towel.

Note M12 connectors must be mated to cables or have caps installed on
them to meet IP65/IP67 requirements. Cover the unused connectors with
the included plastic caps whenever water, dust, or dirt are present.

Note Avoid long periods of exposure to sunlight.

Where to Go from Here

This section lists where you can find example programs for the FieldDAQ device and
relevant documentation.

Example Programs

NI-DAQmx software includes example programs to help you get started
programming with the FieldDAQ device. Modify example code and save it in an
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application, or use examples to develop a new application, or add example code to
an existing application.

To locate NI software examples, go to ni.com/info and enter the Info Code
daqmxexp.

To run examples without the device installed, use an NI-DAQmx simulated device.
For more information, in Measurement & Automation Explorer (MAX), select Help »
Help Topics » NI-DAQmx » MAX Help for NI-DAQmx and search for simulated
devices.

Related Documentation

Each application software package and driver includes information about writing
applications for taking measurements and controlling measurement devices. The
following references to documents assume you have NI-DAQmx 18.5 or later.

FieldDAQ
The FD-11601 Quick Start , packaged with your device, describes how to install
your NI-DAQmx for Windows software, how to set up your FieldDAQ device, and
confirm that your device is operating properly.

The FD-11601 Specifications lists all specifications for your FieldDAQ device. Go to
ni.com/manuals and search for FD-11601.

The FD-11601 Safety, Environmental, and Regulatory Information , packaged
with your device, includes important compliance precautions and connection
information for your FieldDAQ device.

The FD-11601 Calibration Procedure contains information for calibrating your
FieldDAQ device. Go to ni.com/manuals and search for FD-11601.
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NI-DAQmx
The NI-DAQmx Readme lists which devices, ADEs, and NI application software
are supported by this version of NI-DAQmx. Select Start » All Programs » National

Instruments » NI-DAQmx » NI-DAQmx Readme.

The NI-DAQmx Help contains API overviews, general information about
measurement concepts, key NI-DAQmx concepts, and common applications that are
applicable to all programming environments. Select Start » All Programs » National

Instruments » NI-DAQmx » NI-DAQmx Help.

LabVIEW NXG
Refer to the Taking NI-DAQmx Measurements lessons to assist in getting started in
LabVIEW NXG, beginning with NI-DAQmx API Basics. To access these lessons, enter
taking NI-DAQmx measurements in the Search bar in LabVIEW NXG.

Flexlogger
Configuring I/O Channels in the Flexlogger Manual presents information for
configuring channels and logging data in FlexLogger. Go to ni.com/info and enter
the Info Code flexloggeriochannels.

LabVIEW
Use the LabVIEW Help, available by selecting Help » LabVIEW Help in LabVIEW,
to access information about LabVIEW programming concepts, step-by-step
instructions for using LabVIEW, and reference information about LabVIEW VIs,
functions, palettes, menus, and tools. Refer to the following locations on the
Contents tab of the LabVIEW Help for information about NI-DAQmx:
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■  VI and Function Reference » Measurement I/O VIs and Functions » DAQmx

- Data Acquisition VIs and Functions—Describes the LabVIEW NI-DAQmx VIs
and functions.
■  Property and Method Reference » NI-DAQmx Properties—Contains the
property reference.
■  Taking Measurements—Contains the conceptual and how-to information
you need to acquire and analyze measurement data in LabVIEW,
including common measurements, measurement fundamentals, NI-DAQmx
key concepts, and device considerations.

LabVIEW Real-Time
The Real-Time Module Concepts book of the LabVIEW Real-Time Module
Help includes conceptual information about real-time programming techniques,
application architectures, and Real-Time Module features you can use to create
real-time applications. Refer to the Real-Time Module Concepts before attempting
to create a deterministic real-time application.

LabWindows/CVI
The Data Acquisition book of the LabWindows/CVI Help contains Taking
an NI-DAQmx Measurement in LabWindows/CVI, which includes step-by-step
instructions about creating a measurement task using the DAQ Assistant. In
LabWindows™/CVI™, select Help » Contents, then select Using LabWindows/CVI »
Data Acquisition. This book also contains information about accessing detailed
information through the NI-DAQmx Help.

The NI-DAQmx Library book of the LabWindows/CVI Help contains API overviews
and function reference for NI-DAQmx. Select Library Reference » NI-DAQmx Library
in the LabWindows/CVI Help.
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Microsoft Visual Studio Support
You can use the NI-DAQmx .NET class library to communicate with and control an NI
data acquisition (DAQ) device. Documentation for the NI-DAQmx .NET class library
is available by selecting Start » All Programs » National Instruments » NI-DAQmx »
NI-DAQmx Documentation and then opening the NINETDAQmxFxXX.chm help file
corresponding to the version of NI-DAQmx .NET Framework language support you
have installed.

■

Measurement Studio Support for NI-DAQmx—If you program your NI-DAQmx-
supported device in Visual Studio using Visual C# or Visual Basic .NET, you
can interactively create channels and tasks using Measurement Studio and the
DAQ Assistant. Additionally, you can use Measurement Studio to generate the
configuration code based on your task or channel. Refer to the DAQ Assistant
Help for additional information about generating code.

To create an NI-DAQmx application using Visual Basic .NET or Visual C#, follow
these general steps:

1.  In Visual Studio, select File » New » Project to launch the New Project
dialog box.

2. Choose a programming language (Visual C# or Visual Basic .NET), and
then select Measurement Studio to see a list of project templates.

3. Select NI DAQ Windows Application. Choose a project type. You add
DAQ tasks as a part of this step.

■  .NET Languages without NI Application Software—With the Microsoft .NET
Framework, you can use the NI-DAQmx .NET class library to create
applications using Visual C# and Visual Basic .NET without Measurement
Studio. Refer to the NI-DAQmx Readme for specific versions supported.
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ANSI C without NI Application Software
The NI-DAQmx Help contains API overviews and general information about
measurement concepts. Select Start » All Programs » National Instruments » NI-

DAQmx » NI-DAQmx Help.

The NI-DAQmx C Reference Help describes the NI-DAQmx Library functions,
which you can use with National Instruments data acquisition devices to develop
instrumentation, acquisition, and control applications. Select Start » All Programs »
National Instruments » NI-DAQmx » Text-Based Code Support » NI-DAQmx C

Reference Help.

Training Courses

If you need more help getting started developing an application with NI products, NI
offers training courses. To enroll in a course or obtain a detailed course outline, refer
to ni.com/training.

Technical Support on the Web

For additional support, refer to ni.com/support or ni.com/examples.

Many DAQ specifications and user guides and manuals are available as PDFs. You
must have Adobe Reader 7.0 or later (PDF 1.6 or later) installed to view the PDFs.
Refer to the Adobe Systems Incorporated website at www.adobe.com to download
Adobe Reader. Refer to the National Instruments Product Manuals Library at ni.com/
manuals for updated documentation resources.

1 Configurable filtering is supported in NI-DAQmx 18.6 and later. Previous versions of
NI-DAQmx support only brickwall filtering.

2 Configurable filtering is supported in NI-DAQmx 18.6 and later. Previous versions of
NI-DAQmx support only brickwall filtering.
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3 The cDAQ-9138/9139 for LabVIEW Real-Time controllers will not work in this
configuration.
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